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Lecture 1

Using R

Let us start R from the command line. First make a directory, and then run R inside it:
ssh bio41l -X -lcourse

or

ssh bioXX -X -lusername

Then, in the shell do the following:

Shell session inside TeXmacs

shell] cd class
shell] 1s -la

total 24

drwxr-sr-x 2 dirk dirk 4096 Jan 25 16:15

drwxr-sr-x 79 dirk dirk 20480 Jan 25 16:15
shell] R

Now we start R (here I am cheating, and starting R inside texmacs)

library(TeXmacs,lib.loc="/usr/share/texmacs/TeXmacs/plugins/r/r/")

R : Copyright 2003, The R Foundation for Statistical Computing
Version 1.8.1 (2003-11-21), ISBN 3-900051-00-3

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type ’license()’ or ’licence()’ for distribution details.

R is a collaborative project with many contributors.
Type ’contributors()’ for more information and
’citation()’ on how to cite R in publications.

Type ’demo()’ for some demos, ’help()’ for on-line help, or
’help.start()’ for a HTML browser interface to help.
Type ’q()’ to quit R.



> a=b
> q0
Save workspace image? [y/n/cl: y

To quit R use the function q().

After we quit, look at the directory again:

shell] 1s -la

total 32

drwxr-sr-x 2 dirk dirk 4096 Jan 25 16:17 .

drwxr-sr-x 79 dirk dirk 20480 Jan 25 16:15 ..

-rw-r—-r-- 1 dirk dirk 56 Jan 25 16:17 .RData

“rWw-———--- 1 dirk dirk 8 Jan 25 16:17 .Rhistory
shell]

When you quit R asks whether to save everything. If you say yes, then all the data is saved, and loaded
next time you start R from the same directory. The data is stored in the file .RData

library(TeXmacs,lib.loc="/usr/share/texmacs/TeXmacs/plugins/r/r/")

R : Copyright 2003, The R Foundation for Statistical Computing
Version 1.8.1 (2003-11-21), ISBN 3-900051-00-3

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type ’license()’ or ’licence()’ for distribution details.

R is a collaborative project with many contributors.
Type ’contributors()’ for more information and
’citation()’ on how to cite R in publications.

Type ’demo()’ for some demos, ’help()’ for on-line help, or
’help.start()’ for a HTML browser interface to help.
Type ’q()’ to quit R.

[Previously saved workspace restored]

>
> a

(11 5
>

As you see, after restarting, R loaded the data, and thus the variable ’a’ was restored.



TeXmacs

TeXmacs provides a nice interface for working with R.
Do the same as before, but now start texmacs instead of R

shell] cd ~/class

shell] texmacs

The TeXmacs interface

TeXmacs is very similar to Emacs, so if you know Emacs keystrokes, they usually work in TeXmacs.

Help in TeXmacs
To get help in TeXmacs, click on the Help menu

File Edit Insert Session Format Doecument View Go Tools m
COUSeRX % DERDHROC HHF D Welome 571
%%%%|®3§|IBSM Configuration -
Manual P
| Tutorial Browse
Styles
About

First contact
Typing a simple text

Help us [
Projects s
Document format [
Interfacing =
Source code !
Search =
Full manuals P
Online help r

The tutorials are very basic. Try opening one of them.
To close the help that you open, click on File->Close buffer,

Or select another buffer from the ’Go’ menu.

Opening files



To open a file, select "File->Load’, or click on the file open icon.

Fila Edit Isert Text Format Dodiment, View Go Tools Help
Doddeax (2ERRR9DE DOAa#0

= Load buffer... F2 fm| ESVSNaPR
— Revert buffer... C-F2

Load in new window... S-F2

Import Html...

Import LaTeX...

Import Scheme...
Import Verbatim...
Import Xml...

Notice that some entries list their keyboard equivalents.

The status line

At the bottom of the TeXmacs window is the status line. Sometimes, TeXmacs will ask you a question
there - remember to look!

_;“J
There are unsaved files. Really quit? |

Starting R inside TeXmacs

To start R, you need to click on the little monitor icon

2 ‘Reoursel tm
File Edit Insert Text Format Document View Go Tools Help
DadEe¢eaX | snpRhke@ | Hss0
EES=SEE3EEE [ #E ESVSNAF

Scheme

Gnuplot:

Graphviz

Maple

Maxima

Octave

Pari

R

Shell

Other...

Which should give you the following:

library(TeXmacs,lib.loc="/usr/share/texmacs/TeXmacs/plugins/r/r/")



R : Copyright 2003, The R Foundation for Statistical Computing
Version 1.8.1 (2003-11-21), ISBN 3-900051-00-3

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type ’license()’ or ’licence()’ for distribution details.

R is a collaborative project with many contributors.
Type ’contributors()’ for more information and
’citation()’ on how to cite R in publications.

Type ’demo()’ for some demos, ’help()’ for on-line help, or
’help.start()’ for a HTML browser interface to help.
Type ’q()’ to quit R.

[Previously saved workspace restored]

>
Important hints for the R interface in TeXmacs

There are two important icons: the 'STOP’ and the ’scissors’:

=EE==|@%|IBSH

You see them only when you are inside the R session.
The e will stop the current R session, maybe in a long calculation.

The % will exit the current R session, and a new one will be started when another R command is
entered.

If, for some reason the output from the R session becomes uncoordinated with your input, just enter @QQQ@

on an empty input line:

> ©QQ
> a=6
>

(You might then need to hit the (T to regain the input)

Managing R input and Text

To enter text (i.e. non-R input), just click beyond the blue lines that deliniate the R session. To continue
with the R session, just select R from the menu on the monitor icon.

[1] 6



The basics of R

When you enter an exression without parentheses at the end, R prints the expression

> a
[11 6
> q
function (save = "default", status = 0, runlLast = TRUE)

.Internal (quit(save, status, runLast))
<environment: namespace:base>

>

as you see, when we entered 'q’, and not 'q()’, R printed the function q(). To actually call that function,
we have to call it with 'q()’.

More usefull functions in R

help.start() - brings up a help system:

> help.start()
Making links in per-session dir ...
If netscape is already running, it is *not* restarted, and you must

switch to its window.
Otherwise, be patient

>

1s () lists all objects in memory:

> 1s0
[11 "a"
> b=b
> 1sO)
[1] "an b
>

rm() removes an object:

> rm(b)
> 1s()

[1] ngn

Vectors
Data in R is in general stored as vectors, or lists. First we’ll learn about vectors.

When we printed the value of a before, we also saw "[1]”:

> a

[1] 5



>

That is because a is actually a vector that contains one element, 5. There are many methods to create
longer vectors:

> 3:9
[1] 3456789
>

the collon creates a vector in ascending order. The ’[1]” in front of the first element tells us that 3 is ele-
ment number 1. This is usefull for longer vectors:

> -50:50
[1] -50 -49 -48 -47 -46 -45 -44 -43 -42 -41 -40 -39 -38 -37 -36 -35 -34 -33
[19] -32 -31 -30 -29 -28 -27 -26 -25 -24 -23 -22 -21 -20 -19 -18 -17 -16 -15
[37] -14 -13 -12 -11 -10 -9 -8 -7 -6 -5 -4 -3 -2 -1 0 1 2 3
[55] 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21
[73] 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39
[91] 40 41 42 43 44 45 46 47 48 49 50

>
Here we see that -32 is the 19th element of the vector.

We can store a vector in a variable:

> b = 5:100
> b

[1] 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23
[20] 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42
[39] 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61
[68] 62 63 64 65 66 67 68 69 70 71 72 73 T4 T5 76 77 78 79 80
[r7] 81 82 83 84 85 86 87 83 89 90 91 92 93 94 95 96 97 98 99
[96] 100

> length(b)

[1] 96
> 1sO)
[1] ngn upn

>

length() tells us home many elements are in a vector. We can also see that the result of Is() is also a
vector, a vector of strings.

The function ¢() allows us to list elements in the vector one after the other:

> ¢c(1,4,10,2)
[11 1 4 10 2
>

With ¢() you can also join several vectors to one longer one

> c(1,4:9,2)
[11 14567892
> c(1:3,1:3,1:3)



[11 123123123
> a=1:4
> c(a,a,a)

[11 123412341234
> c(a,1s())

[1] wiw nwow ngw wgn wgn upu
>

In the last example you see that when you put a vector of numbers together with a vector of strings, the
result is a vector of strings.

With rep() you can repeat something several times, to create a long vector:

> rep(3,4)

[1] 3333
> rep("R",5)

[1] “R" “R" WR" “R" "R
> rep(1:4,10)

[1] 12341234123412341234123412341234123412
[39] 3 4

>
Subsetting vectors, and operation on vectors

It is easy to get elements of a vector:

> b

[1] 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23
[20] 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42
[39] 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61
[68] 62 63 64 65 66 67 68 69 70 71 72 73 T4 T5 76 77 78 79 80
[r7] 81 82 83 84 85 86 87 83 89 90 91 92 93 94 95 96 97 98 99
[96] 100

> b[2]

[11 6
> b[2]=13
> b[2]

[1] 13
> b

[1] 5 13 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23
[20] 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42
[39] 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61
[68] 62 63 64 65 66 67 68 69 70 71 72 73 T4 T5 76 77 78 79 80
[r7] 81 82 83 84 85 86 87 83 89 90 91 92 93 94 95 96 97 98 99
[96] 100

>

But it is also easy to address subvectors of vectors:

> bl[1:4]



[1] 513 7 8
> b[3:7]

[1] 7 8 9 10 11
> blc(1,3,5)]

[11 579
>
You just list inside the square brackets [] the vector of the elements you are addressing. You can also set
them:
> b[2:6]

[1] 13 7 8 9 10
> b[2:6]=rep(1,5)
> b[2:6]

[11 11111
>b

[1] 5 1 1 1 1 1 11 12 13 14 15 16 17 18 19 20 21 22 23
[20] 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42
[39] 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61
[68] 62 63 64 65 66 67 68 69 70 71 72 73 T4 T5 76 77 78 79 80
[r7] 81 82 83 84 85 86 87 83 89 90 91 92 93 94 95 96 97 98 99
[96] 100

Mathematical operations will usually work on a whole vector:

> a=1:4; print(a)

[1] 1234
> a+2
[1] 3456
> a *x 3
[11 3 6 9 12
>a-“~ 7
[1] 1 128 2187 16384
> sin(a)

[1] 0.8414710 0.9092974 0.1411200 -0.7568025
>

Other than strings and numbers, there are also vectors of boolean values (i.e. TRUE and FALSE)

> a = 1:4 ; print(a)

[1] 1 234
> a<2

[1] TRUE FALSE FALSE FALSE
> a>2
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[1] FALSE FALSE TRUE TRUE
> a==2
[1] FALSE TRUE FALSE FALSE
> ¢(T,T,F)
[1] TRUE TRUE FALSE
>
You see that one can use T and F as an abbreviation for TRUE and FALSE. Also notice that to test for

) )

equality, we used two equal signs: '==".

Boolean vectors give an alternative way to get at elements of a vector: instead of listing the elements that
we want to address, we can give a boolean vector saying if we want or don’t want certain elements:

> a
[11 1 234
> alc(F,T,T,F)]
[1] 2 3

>

This gives us very convenient access to elements:

>b

[1] 5 1 1 1 1 1 11 12 13 14 15 16 17 18 19 20 21 22 23
[20] 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42
[39] 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61
[68] 62 63 64 65 66 67 68 69 70 71 72 73 T4 T5 76 77 78 79 80
[r7] 81 82 83 84 85 86 87 83 89 90 91 92 93 94 95 96 97 98 99
[96] 100

> b[b<12]

(1] 5 1+ 1 1 1 111
> b[b>90] = b[b>90] + 4
> b

1] 5 1 1 1 1 1 11 12 13 14 15 16 17 18 19 20 21 22 23
[20] 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38 39 40 41 42
[39] 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61
[58] 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80
[771] 81 82 83 84 85 8 87 88 89 90 95 96 97 98 99 100 101 102 103
[96] 104

When you join a boolean vector to a numeric vector, TRUE becomes 1, and FALSE becomes 0:

> c¢(T,F,3)
[1] 1 0 3
> a<10

[1] TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE FALSE FALSE FALSE
[13] FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE
[25] FALSE FALSE FALSE FALSE FALSE FALSE

> (a<10)+2
[11 333333333222222222222222222222

11



>

The paratheses above are necessary, and one often needs them in R. Compare:

> a<10

[1] TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE FALSE FALSE FALSE
[13] FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE
[25] FALSE FALSE FALSE FALSE FALSE FALSE

> a<10+2

[1] TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE TRUE FALSE
[13] FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE FALSE
[25] FALSE FALSE FALSE FALSE FALSE FALSE

> 1:10
[1] 1 2 3 4 5 6 7 8 9 10

> 1:10+42

[1] 3 4 5 6 7 8 9 10 11 12
1:(10+2)

[1] 1+ 2 3 4 5 6 7 8 9 10 11 12
length(a)

(1] 30
1:length(a)-1

[1] 0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24
[26] 25 26 27 28 29

1:(length(a)-1)

[1] 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25
[26] 26 27 28 29

\4

\4

\4

\4

I often make the above mistake.

If you want to address all elements but some, you use negative indexes:

> a

[1] 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25
[26] 26 27 28 29 30

> al[-1]

[1] 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26
[26] 27 28 29 30

> al-(1:10)]
[1] 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30

>

What is statistics?

“Statistics is the science of learning from experience” (Brad Efron)

Statistics can do various things, here we will deal with the following:

— Given an experiment we would like to estimate a parameter (in the world).
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— Given an experiment, we would like to test whether a certain hypothesis is can be said to be
unlikely.

These are essencially the same thing. If we knew the world exactly, we would be able to say for sure if a
hypothesis is true or false, and we would know the parameter exactly.

Two factors prevent us from gaining certainty:
1. Sampling
2. Measurement error

Let us look at an example:
Let us say that in a school there are 3000 students, and that we wish to know the average height.
First, let us chose the heights:

> heights=rnorm(3000,mean=170,sd=10)
> hist(heights);v()

Histogram of heights

500
|

Frequency
300
|
|

0 100
|

| | | |
140 160 180 200

heights

>

These are the heights of all the students in school. We can easily calculate their mean:

> mean(heights)
[1] 170.2498
>
Now let us assume that we want to estimate the mean height. we take 10 students, measure their height

with an error of around lcm, and then round to the nearest cm:

> measured.heights=sample (heights, 10)+rnorm(10,mean=0,sd=1)
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> measured.heights=round(measured.heights)

> measured.heights
[1] 176 172 149 186 179 168 146 187 166 160
>

Now we can calculate the mean height in the sample

> mean(measured.heights)
[1] 168.9
>

So, we know that this is the mean of the sample. But what does it say about the real mean? What are
the ranges that we believe now the real mean to be?

If we knew the sampling process, and all the various errors involved in measuring (and in this case we do
know it), then we could estimate how far we are from the real mean.

But how would we know all those parameters? We would have to estimate them, too!

Bootstraping (boot-straping) allows us some magic without all the estimation. It says that a good esti-
mate for distribution that we measured are our measurements. so instead of trying to estimate heights
and their error and sampling, we just sample from the measurements we have:

> b=sample(measured.heights,10,replace=T)

> mean(b)
[11 170.7
> b=sample(measured.heights,10,replace=T)

> mean(b)
[1] 172.2
> b=sample(measured.heights,10,replace=T)

> mean(b)
[1] 169.3
>

Now we have some idea in what range the real mean could be.

So?

This was done to show two things:

1. R is really conventient for addressing such matters. We can easily simulate situations and then
assess our statistical methods.

2. Bootstraping is useful, simple, and (as we’ll see later), convenient to do with R.

Some simple random functions in R

We saw the following 2 ways of generating random data in R:

sample
Sample randomly:

Roll a die

14



> sample(1:6,1)
(11 3
>
Roll 50 die:
> sample(1:6,50,replace=T)

[11 356165132
[39] 516561635

26554114663425543325552226524
6 43
>

or

> sample(6,50,replace=T)

[1] 31353244
[39] 26152131

3411335564525 14314222113656¢6145
2241

>

rnorm

Sample from a normal distibution

> rnorm(10)

[1] -1.9329962 1.0924528 0.5751292 -0.3561676 0.2812530 -1.3551893
[7] -1.4555352 1.7605307 -0.6611010 0.6395928

> rnorm(10,mean=3,sd=0.1)

[1] 3.032633 3.123962 2.989857 3.142417 2.874144 2.855629 3.048683 2.898982
[9] 2.923673 2.987789

> hist (rnorm(1000)) ;v ()

Histogram of rnorm(1000)

Frequency
100 150 200
| | |

50

rnorm(1000)
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